
УПУТСТВО ЗА АУТОРЕ 

 

Редакција часописа Радови Филозофског факултета узима у разматрање радове који 

су сачињени у складу с овим упутством. Осим рада, неопходно је да аутори пошаљу у мејлу 

основне информације о себи (наставно-научно звање и ужа научна област, а за студенте 

докторских студија и самосталне истраживаче, област интересовања). 

Формат:  

Чланке слати у електронском облику на имејл-адресе часописа radovi@ff.ues.rs.ba  или 

radovi@ffuis.edu.ba. Чланак треба припремити у програму Microsoft Office Word у фонту 

Times New Roman. Величина фонта је 12, размак између редова 1,5 (Line spacing 1,5), а 

ширине свих маргина 2,54 (Top, Left, Bottom, Right). Текст равнати на обје маргине 

(Justified). Не треба дијелити ријечи на крају реда на слогове. Сваки нови пасус треба почети 

увлачењем првог реда за 1 cm (Paragraph, First line, 1 cm). Формат странице треба да буде 

А4 (210*297). 

Неопходно је да аутори доставе двије верзије чланка, именоване на сљедећи начин: 

„Назив-рада_1“ и „Назив-рада_2“. Први документ, „Назив-рада_1“, представља интегралну 

верзију рада (с именом, средњим словом, презименом и афилијацијом аутора, евентуално 

напоменама о томе да је рад настао на основу усменог саопштења/урађен у оквиру пројекта, 

као и потпуним библиографским подацима у одјељку „Литература“). Други документ, 

„Назив-рада_2“, не садржи личне податке о аутору, напомене о усменом излагању/пројекту, 

као ни било какве друге информације у референцама које би могле да открију идентитет 

аутора. Тако, уколико се користе аутоцитати, у раду се наводи нпр. (Аутор, 2019: 25), док 

за исту референцу у попису литературе стоји сљедећи податак: Аутор, 20191.  

Такође, неопходно је уклонити све личне податке из doc/.docx датотеке из верзије 

„Назив-рада_2“:  

а) За верзије Microsoft Word закључно са 2003: при чувању документа (File > Save 

As) одаберите опцију: Tools > Security > Remove personal information from file > ОК, па 

затим одаберите опцију Save. 

                                                           
1 Препоручујемо ауторима да документ „Назив-рада_2“ формирају након што у потпуности заврше 

интегралну верзију рада и сачувају је под називом „Назив-рада_1“. 



б) За верзијe Microsoft Word 2007/2010/2013/2016: (2007) кликните на Office button 

> Prepare > Inspect Document, (2010 и даље) кликните на File > Info > Check for Issues > 

Inspect Document, затим одаберите опцију Document Properties and Personal Information 

> и кликните на дугме Inspect. Након завршене провјере кликните Remove All и програм 

ће потврдити брисање личних података. Након свега кликните Close. 

 

Обим:  

Препоручени обим рада износи од 25 000 до 40 000 карактера са размацима, не 

укључујући литературу и резиме, односно до 8 000 карактера са размацима када је ријеч о 

приказима или информативним прилозима. 

 

Језик и писмо:  

Језици на којима се шаљу радови јесу српски (ћирилично и латинично писмо) и неки 

од свјетских језика.  

 

Структура чланка:  

На првој страници рада у горњем лијевом углу уписује се име, средње слово и презиме 

аутора (и коаутора). Иза презимена аутора потребно је звјездицом означити фусноту у којој 

ће бити имејл-адреса аутора (у случају коауторског рада, оба аутора достављају електронске 

адресе, а кореспонденција се одвија са првим аутором).  

Испод имена аутора наводи се пуна афилијација. Код установа са сложеном 

организацијом наводе се организациони нивои, од највишег ка најнижем (нпр. Универзитет 

у Новом Саду/ Филозофски факултет; Влада Републике Српске/ Министарство за 

научнотехнолошки развој, високо образовање и информационо друштво, Бања Лука); код 

институција које немају сложену организацију наводе се назив институције и сједиште 

(Институт за педагошка истраживања, Београд); студенти докторских студија испод имена 

наводе назив универзитета и факултета (Марко Ј. Марковић/ Универзитет у Нишу/ 

Филозофски факултет/ Студент докторских студија), самостални истраживачи испод имена 

наводе свој статус и државу (Марко Ј. Марковић/ Самостални истраживач/ Србија). 

Наслов рада пише се на првој страни испод имена и презимена, центрирано, великим 

словима, фонт 14, болд. Наслов рада (на језику рада) требало би да буде кратак, јасан и 



информативан, пожељно без скраћеница. Неопходно је да наслов што вјерније одражава 

садржај рада. Уколико је рад резултат истраживања на неком од пројеката, дио је мастер 

или докторског рада, излаган на неком научном скупу или уколико аутори осјећају потребу 

да изразе захвалност на подршци некој институцији или појединцу, то је потребно учинити 

у фусноти која ће бити означена са 1 на крају наслова рада (у интегралној верзији). 

Испод наслова пише се апстракт рада који се састоји од 100 до 250 ријечи (без назнаке 

„Апстракт“). Апстракт треба да упућује директно на садржај рада, а неопходно је да укључи 

и научне резултате истраживања/рада. Апстракт се пише у једноструком прореду (Line 

spacing 1), фонт 11, увучен 1 цм са лијеве стране. Први ред сваког параграфа увучен је 

додатно 1 цм. Испод апстракта исписују се кључне ријечи (могу бити и синтагме), чији број 

износи од четири до осам, са назнаком „Кључне ријечи“.   

Пожељно је да текст рада, поготово ако је заснован на емпиријском истраживању, 

буде организован по схеми IMRAD (Introduction, Methods, Results and Discussion). Такође, 

текст се организује по поглављима.  Треба избјегавати поглавља испод трећег нивоа.  

Примјер: 

УВОД (величина фонта 12, велика слова) 

Теоријска становишта о глобализацији (величина фонта 12, мала слова) 

Зигмунд Бауман – глобализација као просторни рат (величина фонта 12, мала слова, 

курзив). 

Табеле, графикони и слике треба да буду дати у оквиру рада и означени одговарајућим 

бројем (редом), те да буду праћени насловом који их описује. Наслов табеле навести изнад 

табеле, а наслов слика и графикона испод њих. Слике треба да буду у резолуцији од 300 dpi. 

 

Цитирање и позивање на друге радове и изворе у тексту: 

Цитирање и позивање на референце врши се искључиво у оквиру текста (не у 

фуснотама). У библиографској парантези наводи се презиме аутора, година објављивања 

публикације и, по потреби, страница са које се нешто цитира. Ако се цитира више сусједних 

страница истог рада, даје се пагинација прве и посљедње странице која се цитира, а између 

њих ставља се црта (Jovanović, 2012: 35–37). Ако се цитира више несусједних страница 

истог рада, бројеви страница одвајају се запетом (Jovanović, 2012: 43, 58). Ако је из 

контекста јасно који је аутор цитиран или парафразиран, у текстуалној библиографској 



напомени није потребно наводити презиме аутора. Нпр: Према Антонићевом мишљењу 

(2011), радикални феминизам је ... 

Уколико се наводи аутор чије је презиме за потребе писања рада транслитеровано, 

приликом првог цитирања користе се угласте заграде у којима дајемо оригиналну графију: 

„Вебер [Weber]“. У наставку рада користимо транслитеровани облик у тексту, а оригинални 

у парантезама. У случају када аутор користи извор који је публикован на језику рада, такође 

је пожељно да приликом првог помињања означи оригиналну графију у угластим заградама.  

Приликом позивања истовремено на неколико аутора унутар исте библиографске 

заграде, њихова дјела наводе се азбучним, односно абецедним редом и одвајају тачком и 

зарезом2. У случају цитирања више радова једног аутора издатих у истој години, потребно 

је да се иза године издавања стави ознака на писму референце (Петровић, 2012а; Petrović, 

2012b)3.  

Уколико се у раду користе садржаји с интернета који немају годину објављивања или 

страницу, али су познати аутори или институције које су их публиковале, они се наводе на 

исти начин као и остали садржаји, с тим што се јасно у парантези наглашава да је ријеч о 

извору са интернета. На примјер: (Kraizer, internet).  

Фусноте се употребљавају само у сврху напомена или давања информација које су по 

мишљењу аутора важне, али би оптерећивале сам текст рада. То могу бити додатна 

објашњења неких појмова, опаске или критике у односу на став неког теоретичара, и сл.  

Уколико аутор у тексту жели да цитира извор који је објављен на неком од страних 

језика, у тексту рада даје превод, а у фусноти даје цитат у оригиналу (у загради наглашава 

да је ријеч о преводу аутора приликом првог таквог случаја).  

 Цитирање у тексту врши се у склопу реченице уколико цитат није дужи од двадесет 

ријечи. Међутим, уколико je цитат дужи о од двадесет ријечи, тада га је потребно издвојити 

у нови параграф (Format, Paragraph, Indents and Spacing, Left 1cm, Right 1cm, проред Single, 

фонт 11) и навести текст без наводника.  

 

Примјери навођења најчешће коришћених референци у тексту: 

                                                           

2
 Уколико се наводе и ћирилични и латинични извори, најприје треба навести оне који су писани на писму 

језика рада, а затим остале.  

3 Писмо језика рада представља начин одабира редослиједа: азбучни или абецедни. 



 приликом сваког навођења 

дјело једног аутора (Jovanović, 2013: 24) 

(Петровић, 2012a: 35–36) 

(Petrović, 2012a) 

дјело аутора настало у 

истој години као и његово 

претходно цитирано дјело 

(Petrović, 2012b: 144) 

(Petrović, 2012b) 

дјело два аутора (Parsons & Bales, 1955: 45) 

(Gavrilović i Stjepanović-Zaharijevski, 2012) 

дјело три аутора (Tomanović, Stanojević i Ljubičić, 2016) 

дјело више од три аутора (Duncan et al., 2014) 

документ институције (Републички завод за статистику, 2018) 

закони (Закон о основама система васпитања и образовања, 2004, 

чл. 5, ст. 2, тач. 3) 

 

Примјери навођења према секундарном извору: 

Уколико аутор није у могућности да наведе извор из прве руке, већ то чини наводећи 

га према секундарном извору, неопходно је означити такав цитат/парафразу на сљедећи 

начин: (Петровић, 2012: 34, према Матић, 2018: 45).  

Илустративни примјери: 

Илустративни примјери дају се издвојени из основног текста; увучени су за 1 cm у 

односу на основни текст и од њега одвојени размаком од 6 pt; величина фонта 11pt. Аутор 

је дужан да нумерише илустративне примјере ради јасног упућивања на њих у самом тексту 

рада.  

 

Литература: 

Од кључне је важности да се цитати и позиви на литературу у тексту и листа 

библиографских јединица на крају текста у потпуности слажу. Позиви на литературу и 

библиографске јединице наводе се у оригиналном писму, без превођења. Прво се наводи 

азбучна/абецедна листа референци на писму и језику рада, прави се размак од једног реда 

(користећи симболе ∗∗∗), а затим се даје листа референци која није на писму језика рада 



(уколико су такве референце коришћене). Пожељно би било да аутори за новије референце 

у списак литературе додају и doi бројеве. У случају да су до референце дошли путем 

интернета, аутори су дужни да наведу линк одакле је референца преузета и датум 

преузимања. Изворе које су користили у раду, аутори могу одвојити у посебан одјељак са 

обавезним насловом „ИЗВОРИ“ уколико сматрају да је то пожељно.   

У литератури је величина фонта 12, размак између редова 1 (Line spacing 1), ширине 

свих маргина 2,54 (Top, Left, Bottom, Right), текст равнати на обје маргине (Justified) и увући 

други и наредни ред за 1,27 cm (Paragraph, Hanging, 1,27 cm).  

 

Примјери: 

 

• Монографије: 

Антонић, С. (2011). Искушења радикалног феминизма. Београд: Службени гласник. 

Parsons, T., & Bales, R. (1955). Family, Interaction and Socialization Process. New York: Free 

press. 

Ellis, R. (2008). The Study of Second Language Acquisition (2nd ed.). Oxford: Oxford University 

Press. 

 

• Рад у часопису: 

Heinz, W. & Kruger, H. (2001). Life-course: Innovations and Challenges for Social Research. 

Current Sociology, 49 (2), 29–45. doi: 10.1177/0011392101049002004. 

Антонић, С. (2013). Друштвена покретљивост у социјалистичкој Србији: један 

ревизионистички поглед. Социолошки преглед, XLVII (2), 145–170. 

doi:10.5937/socpreg1302145A. 

 

• Чланак из онлајн научног часописа: 

Duncan, S., Carter, J., Phillips, M., Roseneil, S., & Stoilova, M. (2013). Why do people live apart 

together? Families, Relationships, Societies, 2.  doi:10.1332/204674313X673419.  

 

• Радови у тематским зборницима, поглавља у приређеним научним 

монографијама, саопштења у зборницима са научних конференција: 



Bobić, M. (2010). Partnerstvo kao porodični podsistem. U A. Milić i dr. (Prir.), Vreme porodica: 

sociološka studija o porodičnoj transformaciji u Srbiji (115–145). Beograd: Institut za 

sociološka istraživanja Filozofskog fakulteta i Čigoja. 

Beechy, V. (1985). Familial Ideology and Social relation. In V. Beechy, & J. Donald (Eds.), 

Familial Ideology (98–120).  London: Open University Press. 

Новаков, П. (2019). Темпорална детерминација енглеских нефинитних клауза и њихових 

српских преводних еквивалената. У М. Кулић (Ур.), Наука и стварност. Књига 13. 

Том 1 (283–298). Пале: Филозофски факултет. 

 

• Докторске дисертације, магистарски и мастер радови: 

Krstić, N. (2018). Reprodukcija simboličkih granica kroz porodične prakse u Srbiji. (Doktorska 

disertacija). Filozofski fakultet Univerziteta u Beogradu. 

http://nardus.mpn.gov.rs/handle/123456789/10302. Preuzeto 21. 9. 2019. 

 

• Документ институције: 

Републички завод за статистику (2019). Месечни статистички билтен. Бр. 11. Бања Лука. 

 

• Одреднице у лексиконима, речницима и енциклопедије 

Lindgren, H. C. (2002). Stereotyping. In W. E. Craighead & C. B Nemeroff (Eds.). The Corsini 

encyclopedia of psychology and behavioral science. (Vol. 4, 1617–1618). New York: 

Wiley. 

Ilić, V. (2007). Funkcionalni odnosi. U A. Mimica i M. Bogdanović (Prir.). Sociološki rečnik. 

(157). Beograd: Zavod za udžbenike. 

 

• Закони: 

Закон о основама система васпитања и образовања (2004), Службени гласник РС. Бр. 62. 

 

• Необјављени историјски извори:4 

                                                           
4 Препоручујемо коришћење скраћеница за навођење оваквих извора у тексту. На примjер: (АЈ).  
Уколико се користе скраћенице, наводе се у библиографији на почетку, одвојене двотачком од пуног 
библиографског извора.  

Уколико аутор не жели да користи скраћенице у раду, онда се оне не користе ни у библиографији: 



АЈ: Архив Југославије. Фонд 313. Министарство просвете ДФЈ (МП ДФЈ). Фасцикла 1. 

Архивска јединица 2. МП ДФЈ – федералним министарствима просвете, бр. 1363, 25. 

мај 1945.  

АС: Архив САНУ. Историјска збирка. Заоставштина Александра Белића, 14386, AB/IV – 

1421. 

DA MSP: Diplomatski arhiv Ministarstva spoljnih poslova Republike Srbije. Politička arhiva 

(PA). Indija, 1955. Fasc. 24. Dosije 36. Sign. 41989. 

 

• Збирке докумената: 

Radić, R. i Mitrović, М. (Prir.). (2012): Zapisnici sa sednica Komisije za verska pitanja NR/SR 

Srbije 1945-1978. godine. Beograd: Institut za noviju istoriju Srbije. 

Zapisnik sa sastanka Komisije za verska pitanja NR Srbije 15. 9. 1954. (2012). U R. Radić i M. 

Mitrović (Prir.), Zapisnici sa sednica Komisije za verska pitanja NR/SR Srbije 1945-1978. 

godine (135–138). Beograd: Institut za noviju istoriju Srbije. 

 

• Текст у дневним или периодичним новинама: 

Радовић, Д. (2008, 11. март). Од Пикаса до Марине Абрамович. Политика, стр. 15. 

Перић, Д. (2009, 3. септембар). Анархизам, инспирација губитника. НИН 3062. 

http://www.nin.co.rs/pages/article.php?id=46080. Преузето 2. 5. 2019.  

 

• Остали извори на интернету: 

Електронске књиге 

Lappin, S. & Fox, C. (2015). The Handbook of Contemporary Semantic Theory. [Wiley Online 

Library]. doi: 10.1002/9781118882139. 

Веб сајт 

Kraizer, S. (2005). Safe child. http://www.safechild.org. Преузето 25. 2. 2020. 

Филмови: 

Ковачевић, С. (продуцент и режисер). (2006). Синовци. [филм]. Србија: Ave Serbia. 

                                                           

Архив Југославије. Фонд 313. Министарство просвете ДФЈ (МП ДФЈ). Фасцикла 1. Архивска јединица 2. МП 

ДФЈ – федералним министарствима просвете, бр. 1363, 25. мај 1945.  



Петровић, Д. (продуцент) и Бјелогрлић, Д. (режисер). (2010). Монтевидео, Бог те видео! 

[филм]. Србија: Intermedia Network и Радио телевизија Србије. 

Епизода телевизијске серија: 

Benioff, D. & Weiss, D. B. (writers) & Patten, V. T. (director). (2001). Winter is Coming. [TV 

series]. In D. Benioff, & D. B. Weiss. (executive producer), Game of Thrones. USA: Home 

Box Office. 

Телевизијска емисија: 

Делић, В. (аутор). (2016). Ја, ми и други: Корешпонденција Златног руна. [телевизијска 

емисија]. Београд: Радио телевизија Србије. 

https://www.youtube.com/watch?v=Sjy6VEi4jAk. Преузето 6. 2. 2020. 

Видео запис: 

Лулић, Ј. (2013, 26. новембар). Драма као књижевни род. [видео запис]. 

https://youtu.be/9h6_h04ZiBQ. Преузето 1. 5. 2014. 

 

Резиме на неком од свјетских језика:  

Прије резимеа, а након списка литературе, у горњем лијевом углу пише се име, средње 

слово и презиме, а испод и афилијација на једном од страних језика. Затим се на средини 

пише назив рада (фонт 14, болд) на истом језику. Испод наслова центрирано треба написати 

Summary (или Zusammenfassung/Резюме итд.). Оптимална дужина резимеа јесте око 500 

ријечи (или највише до 1/10 чланка). Пише се фонтом Times New Roman, вел. 11, проред 

Single. Уколико је рад на страном језику, резиме се пише на српском језику.  

Напомињемо да резиме на крају рада није превод апстракта, будући да и по обиму 

мора бити макар два пута дужи од апстракта. 

 

Прикази и информативни прилози 

 

Име, средње слово, презиме аутора прилога пише се на крају приказа, на десној 

страни. У сљедећем реду пише се афилијација, по истом принципу као и код чланака, а у 

наредном реду електронска адреса аутора приказа.  

Код приказа није потребан апстракт, али је потребно испод наслова приказа у 

парантези навести сљедеће податке о дјелу (догађају) које се приказује, и то сљедећим 



редослиједом: име и презиме писца дјела које се приказује (у случају догађаја: назив 

организатора догађаја); наслов дјела курзивом (односно назив догађаја курзивом); мјесто 

издања: издавач, година издања (мјесто одржавања, вријеме одржавања); укупан број 

страна (за приказ публикације))5. Фотографија дјела/догађаја који се приказује (уколико 

аутор сматра да је потребно) доставља се у оквиру текста у резолуцији од најмање 300 dpi. 

 

За сва додатна појашњења око упутства за припрему рада, аутори се могу обратити 

Редакцији на адресу radovi@ff.ues.rs.ba. 

 

Напомене: 

У једном броју часописа може бити објављен највише један рад једног аутора 

(укључујући коауторски рад). Са друге стране, исти аутор може послати и приказ за број 

часописа за који шаље научни чланак. 

Молимо ауторе да се придржавају техничких упутстава за припрему чланка. Уколико 

рад није усклађен са упутствима, Редакција ће замолити аутора да приступи ревизији рада. 

Поступак техничке дораде чланка не може се поновити више од једном.  

Редакција моли заинтересоване за објављивање приказа и информативних прилога да 

најприје ступе у контакт са Редакцијом и провјере да ли се њихови планирани 

прикази/информативни прилози могу уврстити у наредни број часописа, пошто је број 

таквих прилога ограничен.  

Редакција задржава право да у рецензентски поступак не уврсти чланак за који 

процијени да не спада у тематски фокус часописа. 

Након завршеног процеса рецензије, уколико постоје објективни разлози да чланак не 

може бити укључен у број у припреми, Редакција задржава право да чланак објави у 

наредном броју часописа, односно у року од године дана од прихватања рукописа за 

штампу.  

                                                           
5 Примјер за приказ књиге: 

Зоран Аврамовић: Добрица Ћосић између књижевности и политике. Београд: Завод за уџбенике, 2019, 206 

стр. 

Примјер за приказ догађаја: 

Универзитет у Источном Сарајеву, Филозофски факултет: Наука и стварност. Пале, 18. мај 2019.  



Аутор је одговоран за тачност података које износи у раду, како оних који 

представљају литературу (цитати, парафразе, цитати у цитату) тако и оних који су 

представљени као резултати истраживања.  

 


